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PerfectForms™ Tutorials

This guide includes step-by-step tutorials for the main components of PerfectForms™ including:

Form Designer Layout view

Form Designer Behaviors view

Form Designer Workflow view (including how to set up notifications)

Form Designer Stage and Role Field State Access

Report Designer
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Layout Tutorial: Purchase Order Request

We will build a simple, two-page purchase order request form.

When a request is submitted, it will first be routed to a manager for approval. If approved, then the total purchase order amount is evaluated by logic we
will create in a later exercise. If the total purchase order amount exceeds the threshold then it is routed to two directors for additional approval. Both
directors then need to approve the request.

If the manager or either director rejects the request, then it is immediately rejected.

The form will consist of two pages:

Details page for applicant to complete      Approvals page for manager/directors decision

     

Create the New Form

1. Select the Forms Dashboard.  

2. Click the New button and choose Form from the drop-down menu. 
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Drag Text Objects onto the Form

A form is designed by dragging objects onto the layout canvas. The different object types are categorized in four main sections:

Common Visuals

Common Inputs

Advanced Visuals

Advanced Inputs

As you drop each Text object onto the layout canvas, it will be automatically selected allowing you to start typing in your text.

1. Start your form by dragging six Text objects from the Toolbox  onto the layout canvas. Enter text for each as shown in the image below.

2. Drag and drop a Small Heading object onto the layout canvas. Enter text as shown in the image below. Do not focus on the positioning  of

the object at this time as this will be managed later, just put the objects in the approximate position shown below.

Note: If an object becomes de-selected you can re-select it by double-clicking it.
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3. Drag four Text Input objects onto the form to the right of the four Text objects.

4. Drag a Drop-Down object to the right of the text object Department.

5. Drag a Date Input object to the right of the text object Required Date.

6. Save your form as you go along. From the Form menu, select Save.

Name the Form Objects

It is very important to give the input objects sensible names so they can be easily identified when setting behaviors and designing reports later in this
module.

We will specify an object name for the first text input object on the form.

1. Select the text input object nearest to the Applicant text object. It will be highlighted by a dotted line.

2. In Text Input Properties, enter ‘Applicant Name’ in the Name box.

Repeat the process for the other three text input objects on the page using the names:

Applicant Email

Manager Name

Manager Email

Formatting Options

We will now adjust the layout of the objects on the form using some of the format options. The options include:

Snap to grid

Snap text to neighbor

Align objects
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Make objects the same size

Space objects evenly

Move objects to top/bottom

Group objects together

Using the Snap to Grid option is often the most effective way to line up multiple objects. 

1. From the View menu, select Snap to Grid.

2. From the View menu, select Grid.

Note: In Form Properties, you can modify the grid dimensions and make the grid smaller. It is not necessary to show the grid in order to use
this option but it can help.

3. Move and align the objects on the form.

4. From the View menu, de-select Grid to turn off the grid view.

In Form Properties, the Theme section allows you to edit the default appearance for most object types. If you change an object setting in the theme, it will
change all of the objects of that type on the form.

1. In the Theme section, locate the Small Heading option.

2. Select Bold.

3. De-select Italics.

4. Select an alternative color.

Note: Colors can be selected from the color palette or you can specify an exact hex value. 

5. In the Themes section, locate the Text option.
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6. Select an alternative color and see how it changes all of the text objects on the form.

Change the Form Size

The page size can be modified in Form Properties:

1. Click the background of the layout area outside of the form page. At the top of the Properties bar, you should see 'Form Properties'.

2. In the Size section, change the width to 550 and height to 450 pixels.

Note: It may be necessary at times to use form sizes that require the user to scroll up and down in their browser. It is best though to avoid
page sizes that require the user to scroll left to right. The form size that you choose should be dependent on screen resolution and other
settings on your users' individual PCs. Generally if your users' screen resolution is 1024 x 768 then to keep a form wholly visible in a standard
browser window you should keep the size to below 900 x 500 pixels. There are other factors to take into account such as monitor size and
browser toolbar options.

Edit Other Object Properties

There are four item types that can be selected to have their properties modified:

Form - Load Form Properties into the Properties bar by clicking in the background of the layout canvas but not on the form itself.

Page - Load Page Properties into the Properties bar by clicking on the page background but not on an object or group.

Group - Load group properties by clicking on a group but not on an object.

Object - Load object properties by clicking on an object.

In order to help control the format of the data being input, it is possible to specify a format for individual objects. There are two objects on the form for
applicant and manager email.

1. Select the Applicant Email text input object.

2. In object properties, select Email from the Format drop-down.

3. Repeat for the Manager Email text object.
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Note: The format check for objects will not take place until the form is submitted. The verification process only highlights the object if the wrong format is
used. This feature should be used in conjunction with a mandatory field check which we will see later. If your form has multiple pages, it might be
preferable to use behaviors to perform these checks as each page is completed, rather than wait until the form is submitted. In our example, the form is
submitted once this page has been completed.

1. Select the four text input objects together by clicking each one in turn with the SHIFT key pressed. Each object should now be in the

selected state with a dotted line border.

2. In the Properties bar, scroll down until you get to the Navigation section. Change the width from 160 to 120.

Note: When multiple objects are selected, the properties options are reduced to only show the common properties shared among the selected
objects.

3. Select the Drop-Down object.

4. Change the name to ‘Department’.

5. In the Items section of the Properties bar, click the add item button  twice to add two more options to the list.

6. Select each item caption in the Items list and change to a suitable department name. 

7. Clear the Selected check box for the first item on the list.

8. Modify the width to 120.

9. Select the date object.

10. In the Properties bar, change the name to ‘Required by date’.

11. Change the from years to the current year, as this date object will only be used for future dates.

12. Change the date format to suit your preferred choice.

13. Modify the width to 120.
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Note: In the Properties bar you can expand and collapse the individual sections by clicking the arrows on the blue section title. 

Additional Properties:
If you want to display default text in a text input object when the form first opens then add it in the Text section of the Properties bar.

The default maximum number of characters is 99 but this can also be changed in object properties as can the format of the input text. In our example form
we do not want to change any of these properties. 

Group Objects Together

Grouping objects together can be a very useful feature for working with related objects. A group can be moved as a single item. Later in the training you
will see how using groups can make the management of field states easier, too.

Objects that are grouped together have their positions specified in relation to the group boundaries rather than the page boundaries.

1. Select all of the objects on the form.

2. Right-click and select Group/Ungroup.

Add Images and Page Effects

Images, along with video and sound clips, would normally be stored on your PC or network. In PerfectForms™, these files are known as Assets. To be
able to use these on your forms, they have to be uploaded to the server. 

Note: Before following the add image instructions, please ensure that you have a local image available to upload for use in the form. 

1. Click Browser  to load the Browser bar.

2. In the Assets section, click the New button  .

3. Use the wizard to select the image to upload.

4. Repeat for as many assets that you want to use on the form.
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Now you can drag and drop the image onto the layout area.

1. Click Toolbox  to load the Toolbox bar.

2. Drag a Picture object onto the form.

3. In Picture Properties, select the file in the Asset drop-down.

4. Re-size accordingly.

5. Repeat these steps for additional images that you want to display on the form.

A border can give a nice finishing touch to a page. To add a border:

1. Load Form Properties in the Properties bar (click in the layout area background or use the navigation arrows on the Properties bar).

2. In the Style section, choose Show a frame.

3. Select a suitable color.

4. Select round or square corners for the frame.

Now we will add a separator line to complete the page.

1. Drag a Horizontal Separator onto the form and expand it to the full width of the page.

Add a Table

A table organizes related information into a series of rows and columns. You can define a column to contain different form objects (e.g. text input, button,
checkbox and drop-down).
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1. From the Advanced Inputs section of the Toolbox, drag a Table object onto the bottom half of the form.

2. Increase the table width by clicking on the right edge of the table and dragging the edge to about 90% of the page width.

3. Use the same technique to reduce the height so that only four rows are visible

A table will have two columns as a default setting but you can add additional columns.

1. Select the Table object.

Note: The easiest way to select a table object is by clicking under the bottom row to the right of the buttons.

2. In Table Properties under Columns, click on the Type column in the second row on the list, change it to Numeric Input.

3. Add a new column by clicking the Add button . Repeat to add another column to make a total of four columns.
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Note: Each time you add a column you are invited to manage the column properties but you may prefer to add your columns first before
dealing with their properties.

4. Change the type on three of the new columns to be Numeric Input. Change the remaining column to text input.

Note: When managing table and column properties, you may find it easier to treat the table as a collection of columns (in turn you can
consider each column as an individual object).

Now we can set the properties for each column. Selecting a column can be done in two ways:

1. Select the table object, then in Table Properties double-click in the header column for the column of the table you want.

OR

2. In the layout area, click the header of the column you want to choose.

In both cases the selected column is shown in a different color and the column properties (named after the column type) are shown in the Properties bar.
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1. Change the column name so that it is easily identified later in behaviors and reporting.

2. Specify the column header text and width accordingly. Use the following settings for each column:

Column 1: Column 2:
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Column 3:  Column 4:

The table will be used to collect the purchase order details, but we need a single numeric object on the form to store the calculated total of the request.

1. Add a Text object and change the text to ‘Total’.

2. Add a Numeric Input object and name it ‘Total’.

Add Buttons

We need to add two buttons to this page. When the applicant has completed the request, they will need a button to submit the data. Also, when the
managers access the form, they will need to navigate to the approvals page.

1. Add a Page Button object.

2. Add a Button object (not a Submit button).

Note: The Submit Button object only allows for data to be submitted. In our example we will require more advanced behavior when a user
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submits their request so we used the basic button object instead which allows us to assign more complex behavior than simply submitting the
data.

3. In Button Properties, modify the button caption to ‘Submit’.

Add a Section Heading

Finally we will add some heading objects to visually organize the page.

1. Add a Large Heading object at the top left of the page. Change the text to ‘Purchase Order Request’.

2. Add a Small Heading object between the separator and the table. Change the text to ‘Order Details’.  

3. Rearrange, align and generally tidy up your page to look like this:
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Name the Page

To provide a name for your form page, complete the following steps:

1. Load Page Properties by clicking on the page but not on an object or group (or use the navigation arrows at the top of the Properties bar).

2. Change the page name to ‘Details’. The layout of the first page is now complete.

Add Another Page

Adding a page to your form can be done in two ways:

1. On the Browser bar, click the New button  on the Objects section.

OR

2. From the layout area, click the New Page button  at the bottom.

3. Once the page is opened, name it ‘Approvals’ in the Page Properties bar.

Copy and Paste Images

If you used graphics on the details page you should copy them onto the approvals page to keep a consistent look across your form.

1. Open the details page created in the previous section. 

Note: For forms with multiple pages, you can move between pages by selecting the page from the Browser bar or by clicking the page tabs at
 the bottom of the layout area.

2. Select any graphics and the large heading object (use Shift + click to select more than one object).

3. Go to the approvals page.

4. Paste the graphics. When you copy from one page and paste to another, the objects will be pasted at the same location.
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Add Radio Buttons to the Approvals Page

On the approvals page, you will add input objects which will allow the manager and directors to approve or reject the request and allow space for
comments. 

Note: A pair of radio buttons is the best option for an approved/rejected type choice. The difference between radio buttons and checkboxes is that a
radio button group will only allow a single response whereas a checkbox group will allow multiple responses.

Once you create a single group of approval objects for the manager, you can then copy and paste to create similar groups for the directors. 

1. Add a Radio Group object to the page.

2. Drag the right edge of the group open to cover about 90% of the page width.

3. Select the third radio button and delete since you only need two options.

4. Select the second radio button and move it to the right of the first.

5. Select the group and in Group Properties change the name to ‘Manager Approval Group’. Including the term ‘Group’ in the name often

helps to identify groups when you are creating behaviors and other intelligence for the form later.

6. Select the Has header check box.

7. Change the caption to ‘Manager Approval’.

8. From the Style section of the Properties bar, select Solid from the Border drop-down.

9. Add a Multiline Text Input object to the right of the text and name it ‘Manager Comments’. 

10. Add a Text object next to the multiline text object and change the text to ‘Comments’ (see image below).
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Now you need to modify the radio button properties individually.

1. Select the first radio button.

2. In Radio Button Properties, change the name to ‘Manager Approved’.

3. Change the caption to ‘Approved’.

4. Clear the Checked check box.

5. Select the second radio button.

6. Change the name to ‘Manager Rejected’.

7. Change the caption to ‘Rejected’.

8. Modify the sizes of the objects and group to make room for two additional groups on the page. Suggested group height is a maximum of

115 pixels. 
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Copy and Paste Input Objects

Copy and paste the group you created in the previous steps to create two additional groups: Finance Approval Group and Executive Approval Group. 

1. Select the Manager Approval Group (it will be highlighted with a dotted line).

2. Right-click and select Copy then right-click and select Paste.

3. Select the new group and move it into place, adjusting the size accordingly.

4. Right-click and select Paste again to create a third group.

Note: When you copy and paste objects on a form, the object names are retained. Because of this, it is important that you go into each of the
two new groups and change the names to differentiate the copied objects from the originals. 

5. Where you see ‘Manager’, change to ‘Finance’ and ‘Executive’ accordingly:

The group name

The group header

Both radio button names

The Comments object name

Add Navigation Buttons

1. Add a page button towards the bottom left of the page.

2. In Button Properties, change the caption to ‘Back’.

3. Change the setting to Previous.

4. Add a Button object towards the bottom right of the page (not a Submit button).

5. In Button Properties, change the caption to ‘Submit’.

Note: On Button Properties under the Button Types section, there are mouse-over options you can try for different effects.
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Naming Form Instances

Once the form is in use, the various instances of the form can be seen on the user dashboards. For the purpose of differentiating between form instances,
it is often helpful to set the form up to generate a form instance name using data from that instance. This ensures that users are not presented with a list of
instances which cannot be easily identified. 

The instance name is set in Form Properties and can be fixed text, the value of a single field, value of a special form property or a combination using the 
Formula Editor. The most likely options will be the value of a single field or a combination.

1. Click on the background of the layout canvas and Form Properties will be displayed in the Properties bar.

2. In the Instance Name section, select Formula and click the Compose button.
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3. Choose the Field radio button and click the Select button.

4. Browse to the Details page and select Applicant.

5. Click the Add Line button.

6. Choose Value.

7. Type in ‘: ‘   (Colon followed by a space).

8. Click the Add Line button again.
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9. Choose the Field radio button and click the Select button.

10.  Browse to the Details page and select Department – Caption.

Note: Department is a drop-down object. Drop-down and list objects have two elements; the caption is the text seen in the form and the value
is set in object properties.

11.  Click OK.
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Behaviors Tutorial: Purchase Order Request

We will build a simple, two-page purchase order request form.

When a request is submitted, it will first be routed to a manager for approval. If approved, then the total purchase order amount is evaluated by logic we
will create in a later exercise. If the total purchase order amount exceeds the threshold then it is routed to two directors for additional approval. Both
directors then need to approve the request.

If the manager or either director rejects the request, then it is immediately rejected.

The form will consist of two pages as shown below. Additionally, we will assign the following behaviors to add the following actions:

Mandatory field checking

Perform calculations in the details table

Require fields based on conditions

Details page for applicant to complete      Approvals page for manager/directors decision
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Set up: Loading the Sample Tutorial Form

If you have not completed the form tutorials, you can download a sample tutorial form with the preliminary steps complete by clicking here.

Note: This form is only available for download through the online version of this help guide.

1. To import a PerfectForms™ form (.PF), click the Import button under the Forms Dashboard tab. 

2. Locate the .PF file on your PC. It will then be uploaded and added into your Private Forms folder. 

3. You can upload forms that have been exported from another account or downloaded from the PerfectForms™ Web site.

Add Mandatory Field Checking

When a user submits their purchase request form, we will also check that certain fields have been answered before allowing the data to be submitted.

http://www.perfectforms.com/documentation/downloads/PurchaseOrderTutorial1(Form).zip
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Note: Mandatory fields can also be managed in the Layout view by checking Mandatory Answer on the object properties. However, be aware that
mandatory checks made in this way are not performed until the form is submitted.

1. Open the form in the Form Designer by choosing the Forms Dashboard then locating the form in the Edit Forms tree view. 

2. Click Design on the form detail area.

3. On the Form Layout area, select the Submit button object.

4. On the Properties bar under Behaviors, click Button Is Pressed. The Behavior view for the selected behavior event is opened. In the

Toolbox, you can see the objects that can be used to build the behavior sequence for this event. The sequence could consist of a single

behavior command or a combination of behavior commands with some conditional logic. 

5. Drag and drop a Check Mandatory object onto the canvas.

6. Drag and drop a Submit Data object onto the canvas under the previous object.

7. Join the two objects with an arrow from Check Mandatory to Submit Data using the yellow join points around the edge of each object.

8. Select the Check Mandatory object. In Check Mandatory Properties, click Add.

9. Browse to Details then locate and select the four objects relating to Applicant and Manager name and e-mail.
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10. Click OK.

Note: Multiple selections can be made by pressing the Shift or Ctrl keys while clicking your mouse.

Add a Calculation to a Table Column

Next, we will add some behaviors to the table object. The table object on the form allows the applicant to add detail lines to the request. Once a line has
been added, we need to add behavior to calculate the line value (Qty X Price = Value) and then sum the total in the value column to make the request
value.
As the row calculation is based on the Quantity and the Price we will add the behavior to the 'Field changes' event for both of those items.

1. In Layout view, select the Quantity column object by clicking in the header of that column.

2. On the Properties bar under Behaviors, click the Numeric Input Changes Field Data event.
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3. To set up the row calculation behavior, drag a Set Field command onto the canvas.

Note: The Start and Exit objects are just for visual reference and are not needed as part of the behavior sequence. The sequence will
automatically start at the command that does not have a connector arrow leading to it and run in the direction of the arrows and any
conditional logic that is added. We will see this in a later example.

4. In Set Field Properties there are three areas:

Field - This is where you specify the object field where the result of the behavior will be placed.

Value - The value of the result of the behavior. This could be fixed text, the value of another field, a system field or an advanced
formula.

Summary - This is to set a comment which is a visual cue shown on the command in the Behavior view and does not have any effect
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on the behavior.

5. On the Properties bar in the Field section, click Select.

6. Browse to Details then Table and select Value – Current Row.

7. Choose Formula and click Compose.

8. On the Formula Editor the single <empty> line will be selected. Change the value of the line by selecting the Field radio button.

9. Click Select to open the Select a Field dialog.

10. Browse to Details then Table and select Quantity – Current Row.

11. Click Add Line.

12. Select the + operator and select * in the right hand pane.

13. Repeat steps 8 – 10 above, this time selecting Price – Current Row.

Note: Remember that the table should be considered as a group of objects inside a table and, therefore, it is possible to identify the individual
columns in behaviors.

14. On the Properties bar, clear the Auto-Summary check box.

15. In the Comment box, type Calculating row value = quantity x price.

16. Drag open the Set Field command so you can see all of the resulting text.

Now, we should rename the behavior event to a more easily recognized name. This is optional but often useful.

17. In the Behavior Properties select and modify the event name from 'Numeric Input changes field data' to 'Quantity Changes'.
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Copy a Calculation to a different column

The behavior just created will also have to be copied to the Price column.

1. In Layout view, select the Price column object by clicking in the header of that column.

2. On the Properties bar under Behaviors, click the Numeric Input Changes Field Data event.

3. Start by renaming the behavior event to 'Price Changes'.
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Note: At the foot of the Drawing Canvas, each behavior event has it's own tab. These tabs allow you to toggle to other behavior events quickly
without having to go via the Layout mode to find the events. Each tab can be closed by pressing the x in the tab. Closing a tab WILL NOT
delete the behavior.

4. Click on the 'Quantity Changes' tab to open that event.

5. Select the 'Set Field' behavior on that event and copy it.

Note: There are a few methods available to copy the command. Ctrl+C on a PC (CMD+C on a Mac) or use the right click menu, or use the
Edit menu in PerfectForms™

6. Click on the 'Price Changes' tab to open that event.
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7. Paste the behavior into that event.

The row calculation (Qty x Price) will now be triggered when either the Quantity or Price changes in the table.

Make a Column Calculation using a Function

The Value in a row of the table will now be updated when a change is made to the Quantity or Price row.
We now have to add a behavior to calculate the overall total which will be the SUM of all values in the Value column.

Note: If we just want to display the overall total there are features in the table properties that will do this for us. To learn more about these feature check
the 'Footer' feature in the Table Properties.

Because we also need to use the overall value in the Workflow logic we will make the calculation and store it in the Total field on the form.

1. In Layout view, select the Value column object by clicking in the header of that column.

2. On the Properties bar under Behaviors, click the Numeric Input Changes Field Data event.

3. Start by renaming the behavior event to 'Value Changes'.

4. Add a 'Set Field' command to the drawing area.

5. On the Properties bar in the Field section, click Select and browse to select Total. Click OK.

6. On the Properties bar, next to the Formula option, click Compose.

7. In the Formula Editor, delete the <empty> line by selecting it and clicking the Delete button Delete Button.

8. Click the Add Function button.

9. In the function options, scroll down and select Sum.

10. Click on the <empty> line.
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11. Select the Field radio button and click Select.

12. Browse to Details then Table and select Value – All rows.

13. Click OK and OK again to close the Formula Editor.

Preview the Form to Check Behaviors

You can preview your form to see how it will look and how the behaviors will work when it is published.

1. From the Form menu, select Preview. 

Note: When a form is being previewed, clicking a Submit button will return you to the Form Designer. However, if this is not possible you

should click the close preview button  at the top of the preview screen. Do not close the browser window as this will close PerfectForms™
completely.

2. Click the table add row button .

3. Enter details for description, quantity and price. You should see the effect of the behaviors you just specified, such as the value per row

automatically calculated.

4. Enter a second and third row of details. You should now see the total value being calculated.

5. Now, remove the second row from the table on your form instance by clicking the remove row button . 

Apply a Behavior to Multiple Events

We need to add the same behavior to a new event that updates the calculations when a row is deleted.

1. In Layout view, select the table object.

2. In Table Properties under Behavior, select Row Is Deleted.
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3. From the Toolbox, drag and drop a Run Behavior command onto the canvas.

4. In the Run Behavior Properties, click Select.

5. Browse to the behavior Value Changes.

6. Click OK.

7. Preview your form again to see how this works. This time you can try to submit the form without completing the mandatory applicant and

manager fields. 

Require Fields Based on Conditions

The final set of behaviors will force the approvers to add their comments if they reject the application. If the application is approved then their comments
will be optional. The event that will trigger this behavior is when the applicant clicks the Submit button on the approvals page.

Before we set this behavior, let’s consider some of the logic involved and what conditions we need to add into the behavior sequence. We want to ensure
that if the manager or a director rejects the request, comments are added. If a request is approved then comments are optional. 

Remember that once a request is rejected, it will move to the Rejected stage. For this reason, only one person will ever reject a request. So when the
submit button is clicked we need to check each of the approvers in turn to see if any has selected Rejected. If they did, then we should check that the
corresponding comments have been made before allowing the data to be submitted. If the first approver has not selected Rejected, then check for the next
approver.

1. Open the Approvals page, select the 'Submit' button and in the Properties panel select the 'Button is pressed' event.

2. Add a Simple Branch command to the drawing area

Note: The Simple Branch command uses an IF condition that can have a maximum of two join lines exiting it. The first join line is the true
condition and the second join is the false condition. You are not required to specify a false condition. If you want the behavior to execute
beyond a certain point only if a condition is true, then just use one single join line.

3. On the Properties bar of the simple branch, select the simple condition Manager Rejected is checked. 

4. Add a Check Mandatory command and link it as the True condition to the branch command.
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5. Add a Submit Data command and link it to the Check Mandatory command.

6. Select the Check Mandatory command and in Properties select Manager Comments as the mandatory command. Specify a suitable

message.

7. Add a second Simple Branch command with the condition Finance Rejected is checked. Join this as the False condition to the previous

branch.

8. Add a Check Mandatory command to check that Finance Comments have been answered under the True condition.

9. Join the Check Mandatory command to the Submit Data command.
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10. Repeat the above for the Executive approval.

11. Add a 'False' path from the last simple branch command. This is to permit the form to be submitted without any mandatory fields in the case

where no rejection has been made. You should end up with a diagram that looks like this.

Note: Check the connector arrow style options to see how the curved arrow is chosen.

Note: While we have used Simple Branch commands for this exercise, there is also a multiple branch command available. With a multiple
branch, you can have any number of exit paths and the condition is set on the path arrow.
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Save and Preview the Form

Use the preview function to see your form.

1. On the menu bar, select File > Preview. PerfectForms™ launches the preview screen.

2. Close the form by clicking the close button  in the top right area of the screen.
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Workflow Tutorial: Purchase Order Request

This tutorial describes the workflow associated with a purchase order request (as built in the Layout Tutorial). 

Purchase Order Request Workflow Overview:

1. When the purchase order request form is submitted, it will be routed to a manager for first approval. 

2. If approved, then the total purchase order amount is evaluated. 

3. If the total purchase order amount exceeds the threshold then it is routed to two directors for additional approval. 

4. Both directors then need to approve the request.

5. If the manager or either director rejects the request, then it is immediately rejected.

From this understanding of the process, we can work out the following workflow components:

1. Logical stages of the workflow:

New Application

Manager Approval

Director Approval

Approved

Rejected

2. Roles involved:

Applicant

Manager

Finance Director

Executive Director
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Set up: Loading the Sample Tutorial Form

If you have not completed the Layout Tutorial and Behaviors Tutorial sections, you can download a sample form with the preliminary layout complete by 
clicking here.

Note: This form is only available for download through the online version of this help guide.

1. To import a PerfectForms™ form (.PF), click the Import button under the Forms Dashboard tab.

2. Locate the .PF file on your PC. It will then be uploaded and added into your Private Forms folder. 

3. You can upload forms that have been exported from another account or downloaded from the PerfectForms™ Web site.

http://www.perfectforms.com/documentation/downloads/PurchaseOrderTutorial2(Form).zip
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Open the Form in Workflow View

1. On the Forms Dashboard, locate the sample purchase order request form in the tree. 

2. Click Design. 

3. On the layout area, load the Workflow view by clicking the Workflow button .

4. The Toolbox now contains only Stage and Comment objects. The Workflow properties are displayed in the Properties bar.

Define the Workflow Stages

Logical stages of the workflow:

New Application

Manager Approval

Director Approval

Approved

Rejected

We need to take this information and transfer it onto the workflow diagram and properties.

1. From the Toolbox, drag five Stage objects onto the canvas.

2. Select each stage and name it in the Stage Properties according to the logical stages we just listed.

3. Make sure that the New Application stage has the Is Default Stage property turned on.

4. For the Approved and Rejected stages, select the Is Closed Stage check box for each. The stage color will change to show that the stage is

now a closed stage.
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Note: In Workflow Properties, you will see a warning that there is no logical flow. This is because the stages are not linked together yet.

Join the Stages

Stages are linked by path arrows. 

1. Arrange the stage objects as shown in the image below.

2. To link two stages together, move your mouse over the edge of a stage object until you see a yellow dot join point. Click on the join point

and drag your mouse to a join point on the next stage in the sequence.
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3. You can also drag and drop Comment objects to annotate the workflow diagram.

Name the Paths

Name and Path Arrow Style properties are simply visual indicators but they are important to use on the diagram. They do not affect workflow intelligence
but they can help other people understand the workflow logic and can often refresh your own memory. Try to use them even if the information seems
obvious at first.

In our example, we will put a description of the event that triggers the instance to move between stages, in the Name property. These descriptions will help
anyone reviewing the workflow in the future.
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Every time an instance of the purchase order request form is created and submitted, it will always progress to the Manager Approval stage.

1. Select the path between the New Application stage and Manager Approval stages.

2. In Path Properties, enter the Name property as ‘New application is submitted’.

Note: We are only putting a visual cue on the diagram and not setting the actual conditions which we will do in the next section.

If the manager rejects the request then it will progress to the rejected stage regardless of the request value.

1. Select the path between the Manager Approval and Rejected stages.

2. In Path Properties, enter the Name property as ‘Manager rejects’.

If the manager approves the request then it will either a) progress to the approved stage if the total request value is under $10,000, or; b) it will
progress to the director approval stage if the request value is greater than that threshold.

1. Select the path between the Manager Approval and Approved stages.

2. In Path Properties, set the Name property to ‘Manager approves and value < 10,000’.

3. Select the path between the Manager Approval and the Director Approval stages.

4. In Path Properties, set the Name property to ‘Manager approves and value > 10,000’.

If an instance reaches the director approval stage then it will either a) be approved by both directors and progress to the approved stage, or; b)
it will be rejected and progress to the rejected stage.

1. Select the path between the Director Approval and Approved stages.

2. In Path Properties, set the Name to ‘Both directors approve’.

3. Select the path between the Director Approval and Rejected stages.

4. In Path Properties, set the Name property to ‘Either director rejects’.
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Define the Path Conditions

We now need to define the workflow rules on the paths.  

The condition specifies under which circumstances a form instance’s workflow will progress along that path to the next stage. These conditions are a key
part of the workflow rules and there are three main options for applying these conditions:

Always, if no other condition is met

Simple - Interrogates the state or value of a single field in the form 

Advanced - Interrogates the state or value of multiple fields in the form

We know that the purchase order request form will always progress from the New Application stage to the Manager Approval stage so this is the
condition to set on the path between these stages.

1. Select the path between the New Application and Manager Approval stages.

2. In Path Properties, verify that the condition Always, if no other condition is met is selected by default.

For an instance to progress from the Manager Approval stage to Rejected stage, the workflow will need to determine if the Manager Rejected
radio button has been selected. A simple condition can be used here.

1. Select the path between the Manager Approval and Rejected stages.

2. In Path Properties, change the condition to Simple.

3. Click Select and then the Select a Field dialog will open.

4. Select the field that the condition will reference. Navigate through Approvals then expand Manager Approval Group and select the

Manager Rejected radio button. Click OK.

5. From the drop-down, select Is Checked.
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Now you can see that giving your pages, groups and objects sensible names in the form layout process makes them much easier to locate when you are
building workflow rules and behaviors.

Define Advanced Path Conditions

The other paths on the diagram will have conditions which are based on the status of more than one object on the form. For these paths we need to use
the advanced condition option.

1. Select the path between the Manager Approval and Approved stages.

2. In Path Properties, select Advanced and click Edit.
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In this example, the condition that we want to set is if the Manager Approved radio button is selected AND the value in the Total field is less than
10000, then the path will be activated in the workflow. Build the condition line by line as follows.

1. In the Condition Editor, choose the Field radio button and click Select.

2. Browse to select Manager Approved. Click OK.

3. Back on the Condition Editor, click Add Line.

4. Select State and leave the default option Checked selected.

5. Click Add Line. The editor adds an equals sign (=) in addition to a new line.

6. Click on the equals sign (=) and the operator options will be shown on the right.

7. Select logical AND.
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8. Click on the <empty> line.

9. Choose the Field radio button and click Select.

10.  Browse to Details and select Total. Click OK.

11.  Click Add Line.

12.  Click on the new equals sign (=) just created.

13.  On the right, select the operator is less (<).

14.  Click on the <empty> line.

15.  Select Text or number. 

16.  Enter '10000' and click OK. Your condition editor should look like this:
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Next, create the condition for the path between the Manager Approval and Director Approval stages. It is virtually identical to the previous
exercise but with a different operator.

1. Select the path between the Manager Approval and Director Approval stages.

2. Repeat the previous instructions but at Step 13 select the operator is greater or equal (>=).

Note: It is possible to Copy and Paste conditions from one path to another by selecting the condition in the condition editor

Complete the final two path conditions.

1. Select the path between the Director Approval and Approved stages.

2. On the Path Properties, choose Advanced. 

3. In the Condition Editor, set the advanced condition as shown in the image below.

4. Select the path between the Director Approval and Rejected stages.

5. In the Condition Editor, set the advanced condition as shown in the image below.
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Create and Define the Roles

Roles relate to the stakeholders in your process and play an important part in managing how the form instance reacts and progresses at different stages
of its life. The roles are not the same as a position in an organization and can often be different for each instance. One individual in your organization
might be an applicant in one instance, but a manager in another.

Roles involved:

Applicant

Manager

Finance Director

Executive Director

When a role is specified, there is an option to map the role to identify a specific individual or group who may assume the role. In many cases, the
individual will be identified by their e-mail being added into the form, as is the case with our first example.

Note: It is best practice to assign roles in your workflow to positions or user groups instead of specific users. This requires less maintenance after staff
changes. Your system administrator may need to create the positions you require if you do not have privileges to do so.

1. Click on the workflow diagram but not on a specific stage, path or comment to load the Workflow Properties in the Properties bar.

2. Under the Roles section, click the Add button four times. Four new roles are now listed.

3. Select the first role. Re-name the role to ‘Applicant’.

4. Click Edit.

Note: Once a role has been defined, it will be listed in the roles box in alphabetical order.

5. Choose Email Taken From a Field and click Select.

6. Browse to Details then locate and select Applicant Email.

7. Click OK.
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We can do the same for the next role.

1. Select the second role.

2. Re-name the role ‘Manager’.

3. Click Edit. Map the role to Manager Email.

Note: You are not required to map a role to an individual, position or group. If your process allows you to do that then it can save a lot of time
later. You will see, however, that it is also possible to map the role to an individual, position or group at the notification stage.

You may choose to map a role to a PerfectForms™ system position or group. For the Finance and Executive Directors, we will map to positions
that have already been created.

To learn about creating Positions check the main help guide by clicking here

1. Select the third role.

2. Re-name the role ‘Finance’.

3. Click Edit and choose Position. 

4. Click Select and browse to select CFO or an alternative position.

5. Select the fourth role.

6. Re-name the role ‘Executive’.

7. Click Edit and choose Position. Browse to select CEO or an alternative position.

Notifications Based on Workflow Paths

You can now set up notifications to be sent at various points in the workflow. Notifications allow you to:

Give users, groups and positions access to a form instance. 

http://www.perfectforms.com/Documentation/manual/html/index.html?d_positions.htm
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Set a level of attention if it is important.

Send a message which is visible on the users portal. This message can contain data from the individual form instance. 

Also send a message by e-mail for users who do not access the Dashboard as frequently. 

Create reminders and escalations.

The notifications, like the workflow conditions, are specified in the workflow path arrow properties.

1. Select the path between the New Application and Manager Approval stages.

2. In Path Properties under the Behavior section, click the Edit button. The Behavior view for that path will open.
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3. From the Toolbox, drag and drop a Notify command.

4. In Path Properties, click Edit. The Edit Notifications screen will open. This is where you can specify one or more notifications for when the

condition on the path is met and the form instance moves from New Application to Manager Approval.

Notification: Request Received

The first notification will be to the applicant (using the e-mail entered in the Applicant E-mail field).

1. Click the Add button to create a notification. This notification will allow the applicant to access the instance from the Notifications

Dashboard. No attention is set because there is no action required.

2. In the General tab you set a title, which will be shown on the Notifications Dashboard, a level of attention and a role if required.

For Title, enter Request Sent.

For Attention Level, select No attention needed.

For Role, select Applicant.

Note: If you select Unspecified as the role then you will need to specify the recipient of the notification on the Person tab.

3. Click the Person tab. The Person tab is where you can override the role to set another recipient. This is not necessary for your form as the

default setting of Person assigned to this role is suitable.

4. Select the Time tab. The Time tab is where you can specify a time or a delay for the notification. This is not necessary for your form as the

default setting of Now is suitable.

5. Select the Cancellation tab. The Cancellation tab is where you can specify a condition for when the notification should be removed from

the Notifications Dashboard view. This is not necessary for your form as the default settings of the instance’s stage have changed and All

Notifications of the Instance option is suitable. The instance will only move to the next stage once the request has been approved or

rejected, so this default condition is a suitable trigger to remove the notification from the manager’s view.

6. Select the Message tab. In the Message tab you can enter a message for the recipient(s). This message can include data from the form
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instance. This tab is also where you can determine whether or not you want to send the notification by e-mail. You can enter plain text on

the Text tab or you may choose the HTML tab to add HTML elements to your e-mail notification. The Send by email check box will default to

checked. Leave this option turned on if you wish the courtesy notification to be sent by e-mail.

7. In Subject, enter Request Sent.

8. In the message body, enter Your request has been submitted and will be processed.

9. Select the Email tab. If alternative email servers have been specified by your system administrator, they can be selected here.

In the same notification command we also have to notify the manager so they can access the form and make their decision.
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1. Click the Add button to create a new notify statement in the same command.

2. On the General tab:

For Title, enter Request Waiting.

For Attention Level, select Normal attention needed.

For Role, select Manager.

3. The Person, Time and Cancellation tabs can remain unchanged.

4. Click the Message tab. 

5. In Subject, enter Request Waiting.

6. For the message body, enter A request has been made by (make sure there is a space at the end).

7. Click Insert Field.

8. Browse and select Applicant Name (shown in brackets).

9. After the applicant name, enter  which is waiting for your approval. (Make sure there is a space at the beginning.)

10. On a new line enter Click  (Make sure there is a space at the end.)

11. Click Insert Link. This provides a link enabling the manager to open the form directly.

12. Put your mouse cursor inside the link, delete the word link and replace it with the word here.

13. After the link enter  to access the request. (Make sure there is a space at the beginning.)
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Set Up Reminders

We have set a level of attention which will be seen on the manager’s Notifications Dashboard view, but we can also set up a reminder which can be sent if
a request is not approved or rejected in a specified time.

There is no limit to the number of reminders you can set up. You can even escalate to a different person, position or group if the instance is still not dealt
with after several reminders. 

1. On the same Notify command, click Add.

2. On the General tab:

For Title, enter Reminder of request waiting.

For Attention Level, select High attention.
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For Role, select Manager.

3. The Person tab may remain unchanged.

4. Click the Time tab.

5. Select After a fixed period and select 1 working day.

6. The Cancellation tab may remain unchanged.

7. In the Message tab, use the same settings and text which was used in the previous notification message, but add in some text to show that it

is a reminder.

8. Be sure to leave the Send by email option turned on. Because this is a reminder it is worth also sending the notification by e-mail.

Note: If you are confident that your users will access the Notifications Dashboard to get their notifications then you can reserve e-mail
notifications for important instances and reminders. If a user is bombarded with e-mail notifications there is always a chance that more
important notifications can go unnoticed.

9. Click OK.

Notification: Request Approved

Now consider the path between Manager Approval and Approved. This path will be taken if the manager has approved the request and the value is under
the value threshold. In this case we want to inform the applicant that their request has been approved.

1. Select the path between the Manager Approval and Approved stages. 

2. Add a Notify command.

3. Edit the Notify command and click Add to create a notification. On the General tab:

For Title, enter Request Approved.
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For Attention Level, select No Attention Needed. As the approved stage is marked as a closed stage, any notifications with attention

would automatically get canceled and would not be seen in the attention needed section of the Notifications Dashboard. 

For Role, select Applicant.

4. Click the Message tab.

5. Confirm that Send by email is selected.

6. Enter a suitable subject and message.

Note: Unless you want to send a message by e-mail there is no reason to set a notify command on this path due to the reasons given above.

Repeat the exercise for the path between the Director Approval and Approved stages.

Note: You can use copy and paste with the Notify command you already created. Remember, however, that before you can paste a command into a
new behavior, you need to click the background of the canvas to make it active. Toggling between canvases by clicking the tabs at the bottom does not
automatically make the current view active.

Notification: Request Rejected

A very similar exercise can be undertaken for the two paths that lead to the Rejected stage. However, in these instances we will include some data in the e-
mail which reflects why the request was canceled.

1. Select the path between the Manager Approval and Rejected stages. 

2. Add a Notify command.

3. Edit the Notify command and click Add to add a notification. On the General tab: 

For Title, enter Request Rejected.

For Attention Level, select No attention needed.

For Role, select Applicant.
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4. Click the Message tab.

5. Confirm that Send by email is selected.

6. Enter a suitable subject and message inserting the Manager Name and Comments fields as shown in the image.

The path between the Director Approval and Rejected stages cannot be set up exactly the same as between the Manager Approval and Rejected stage.
This is because either of the directors could have rejected the case and we should make sure that the right set of comments are used in the notification e-
mail. We should use some conditional logic on this path.

1. Select the path between the Director Approval and Rejected stages.

2. Add a Multiple Branch command. 
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3. Add two Notify commands.

4. Link from the branch to both Notify commands.

5. On the Path Properties for one path, select the Simple condition Finance Rejected = checked.

6. On the second path select the Simple condition Executive Rejected = checked.

7. On the Finance Rejected path, edit the Notify command and click Add to add a notification. On the General tab:

For Title, enter Request Rejected.

For Attention Level, select No attention needed.

For Role, select Applicant.

8. Click the Message tab.

9. Confirm that Send by email is selected.

10.  Enter a suitable subject and message inserting the Finance Comments field as shown in the image.



PerfectForms™ Tutorials 63

© 2015 PerfectForms™

11. Repeat for the Notify command on the Executive Rejected path but with a suitable message and inserting the Executive Comments in

place of the Finance Comments.

Notification: Request Waiting for Review

The final notification behavior to manage is on the path between Manager and Director Approval. The logic in this behavior is slightly different because we
are notifying two individuals at the same time. We do not know which director will enter a decision first.

We cannot rely on the condition when the instance’s stage is changed to act as the trigger to cancel notifications or reminders because we could
easily have the situation where one director has visited and approved a request, but the second has not. We need to use different logic for cancelling
notifications and reminders.

1. Select the path between the Manager and Director Approval stages.
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2. Add a Notify command.

3. On the Properties bar, click Edit. 

4. Add a notification. On the General tab:

For Title, enter Request Waiting.

For Attention Level, select Normal attention.

For Role, select Finance.

5. Click the Cancellation tab. 

6. Check the This Condition is Met option and click Edit. We will set a condition on the cancellation of this notification. Once Finance has

approved the request, we want to cancel their notification but NOT the notification to the executive (who may not have seen the request yet). 

We will set a condition for cancellation of the notification.

If either of the directors rejects the request then the instance progresses to the ‘Rejected’ stage which, due to it being a closed stage, will mean all the
notifications will be canceled automatically. Only if the finance director approves the request do we need to cancel this particular notification.

1. In the Condition Editor, select Finance Approved = Checked and click OK.

2. Select the This notification only option.

3. Select the Message tab.

4. Enter a suitable subject and message.

We need to set up a notification to the executive director.

1. Add a Notify command. Click Edit and add a notification. On the General tab:

For Title, enter Request Waiting.

For Attention Level, select Normal attention.
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For Role, select Executive.

2. Select the Cancellation tab.

3. Check the This condition is met option and click Edit.

4. In the Condition Editor, select Executive Approved = Checked and click OK.

5. Select the This notification only option.

6. Select the Message tab.

7. Enter a suitable subject and message.

As this pair of notifications carries with it a requirement to act on an instance, we will also specify a reminder if the directors do not make their decision in
one working day.

1. Click Add to create a notification. On the General tab:

For Title, enter Reminder of request waiting.

For Attention Level, select High attention.

For Role, select Finance.

2. Click the Time tab.

3. Specify After a period of 1 working day.

4. Click the Cancellation tab. We will set a condition on this reminder.

5. Check the This condition is met option and click Edit.

6. In the Condition Editor, select Finance Approved = Checked and click OK.

7. Select the This notification only option.

8. Select the Message tab.
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9. Add a suitable subject and message. Try copying and pasting the previous message and adding ‘REMINDER’ into the text.

Repeat the above for the executive director reminder.
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Stage and Field State Tutorial: Purchase Order Request

This tutorial is based on a Purchase Order Request form with the following workflow:

1. When the purchase order request form is submitted, it will be routed to a manager for first approval. 

2. If approved, then the total purchase order amount is evaluated. 

3. If the total purchase order amount exceeds the threshold then it is routed to two directors for additional approval. 

4. Both directors then need to approve the request.

5. If the manager or either director rejects the request, then it is immediately rejected.

Set up: Loading the Sample Tutorial Form

If you have not completed the Layout, Behaviors and Workflow tutorials, you can download a sample tutorial form with the preliminary steps complete by 
clicking here.

Note: This form is only available for download through the online version of this help guide.

1. To import a PerfectForms™ form (.PF), click the Import button under the Forms Dashboard tab. 

http://www.perfectforms.com/documentation/downloads/PurchaseOrderTutorial3(Form).zip
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2. Locate the .PF file on your PC. It will then be uploaded and added into your Private Forms folder. 

3. You can upload forms that have been exported from another account or downloaded from the PerfectForms™ Web site.

4. If you have downloaded and imported the sample form from the above link, it will be necessary to re-map the roles of Finance and

Executive to suitable Positions or Users in your PerfectForms™ system. If you plan to re-map positions, make sure that two suitable

positions have been created for your account. Contact your system administrator for details. To re-map positions, complete the following

steps:

a. Open the form in design mode and click the Workflow area button  to access the Workflow diagram.

b. Click in the background of the diagram to select Workflow Properties.

c. Select the Executive role and click Edit.

d. Re-map to a Position or a User by selecting the appropriate radio button and clicking the Select button.

e. Repeat the process for the Finance role.
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f. Save the form and exit.

Turn on Field Object Markers

1. Open the form in the Form Designer by choosing the Forms Dashboard then locating the form in the Edit Forms tree view.  

2. Click Design on the form detail area.

3. Select the Browser  option from the Toolbox bar.

4. From the View menu select Object Markers. This will show visual state markers where a special state is selected.

Set Initial Input Fields to Read-Only

In our example form, we would not want anyone to modify the data once the applicant has made a new request. So, for most of the form instance’s life,
these objects should be read-only.

1. Make sure that the Stage/Role combination is set to All/All on the Browser bar.

2. Select the top six input objects (hold Shift key down to select them together).

3. In the Properties bar, set the State to 'Read-Only'.

The 'padlock' icon signifies that the state of the field is 'Read-Only. The icon is only visible in design mode.
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New Application Stage

While most of the time these items will be Read-Only, when the form instance is a new application, these six objects need to be Normal (visible and
editable).

1. On the Browser bar, change the Stage to 'New Application'.

2. With the top six input objects still selected, or re-select them if necessary, set the State to 'Normal'.

Important: When you select the Default stage, which in this case is New Application, you MUST leave the Role as "All". The role of "Applicant"
is not specified until the form instance has been submitted as a new request.
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Manage Table Object States

Next, we will manage the table object. Remember that the table object is a collection of objects (columns) inside a single table object. When field states are
concerned, it is possible to treat each column as a separate object with separate states.

1. With Stage/Role combination as All/All, select the Description column. To select a table’s column, click on the column header and the

column takes on a darker background.

2. Set the State to 'Read-Only'.

3. Repeat for the other three columns. Note that the state markers are not shown for the table object columns.
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4. In the Browser bar, change the Stage selection to 'New Application'.

5. Select the Description column again.

6. Set the Stage to 'Normal'.

7. Repeat for the Quantity and Price columns, but NOT for the Value column.

Note: The Value column will always be calculated by the form behavior, so it should remain read-only at all times. The Total will always be
calculated so it should remain read-only at all times.

8. With Stage/Role combination as All/All, select the Total object.

9. Set the State to 'Read-Only'.

10. Repeat the process for the Table (not any specific column). Set the state for Stage = All & Role = All to Read-Only.

11. Set the state of the table for Stage = New Application & Role = All to Normal

Note: Setting the state of the Table to Read-Only will prevent any new rows from being added and any existing rows from being deleted but it
will not prevent data in existing rows from being modified. It is the state of the Table Columns being Read-Only that prevents the data from
being modified.

Show Buttons Depending on Stage

Only when the form instance is new should the Submit button be shown. For the remainder of the life of the instance, it should be hidden. The navigation
button will be the opposite, hidden when the stage is New Application.

1. With Stage/Role combination as All/All in the Browser bar, select the Submit button.

2. On the Properties bar, set the State to 'Hidden'.

3. Select the Next page button.

4. On the Properties bar, set the State to 'Normal'.
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5. On the Browser bar, change the Stage to 'New Application'.

6. Select the Submit button again and on the Properties bar set the State to 'Normal'.

7. Select the Next page button again and set the State to 'Hidden'.

Note: After your initial testing, you can move the Next button onto the same position as the Submit button since the two buttons will never be
displayed at the same time.

Manage acces to the Total field

The value in the Total field will always be populated by Behavior, no user should be permitted to modify the data manually

1. With Stage/Role combination as All/All in the Browser bar, select the Total field.

2. On the Properties bar, set the State to 'Read-Only'.

Manage Access to the Approvals Page

Next we will manage the Approvals page. Several objects on this page with the exception of the buttons are in three groups. Groups can make the process
of setting field states much easier as long as all of the objects in the group have the same rules.

1. Open the Approvals page.

2. With Stage/Role combination as All/All on the Browser bar, select all three groups (holding down the Ctrl key to select all three groups

together).

3. On the Properties bar, set the State to 'Disabled'. Most roles will never need access to these fields so Disabled will be the default state.
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4. Now we have to set the exceptions. With Stage/Role combination as Manager Approval/Manager in the Browser bar, select the Manager

Approval group.

5. On the Properties bar, set the State to 'Normal'.

6. On the Browser bar, change the Stage/Role combination to Director Approval/Finance then select the Finance Approval group.

7. On the Properties bar, set the State to 'Normal'.

8. On the Browser bar, change the Stage/Role combination to Director Approval/Executive and select the Executive Approval group.

9. Set the State to 'Normal'.
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10. After setting your field access rules for the form, you can turn off State Markers from the View menu.

Testing with Various Stage/Role Combinations

You can do some basic testing of behaviors and field states using the Preview option in the Form Designer. One of the features of the preview option is to
be able to check how your form acts at the different combinations of stage and role. Before you initiate a preview, you need to select the required Stage/
Role combination on the Browser bar.

Previewing All Stages/All Roles

Previewing in the All Stages/All Roles combination allows you to test how the form will work in the default stage, like a new instance would act.

Note: Using preview in this way allows you to check one stage at a time. But it does not allow you to create an instance and then see that instance work
through the various different stages.

1. On the Browser bar, ensure that the Stage/Role combination is 'All/All'.

2. From the Form menu, select Preview. The form opens as a new instance. 

3. If your form has been built correctly, it should behave as follows:

It is possible to add data in any of the top six input objects.

In the two e-mail fields you get a red outline warning if you do not use an e-mail format. Move your mouse over the boxes to get more
detail.

In the table object you can enter data in the Description, Quantity and Price columns but not in the Value column.

The Value column is calculated (Quantity x Price).

The Total is calculated and you are not able to change the result.

The Submit button is shown but the Next button is hidden.

If you leave any of the top four mandatory input fields blank and click Submit, you receive a warning message and cannot submit the
form.

4. If you do not see all of the above then you may have done something incorrectly; review the documentation to double-check your work.
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Previewing as the Manager Role

We can now verify how the form will work when the manager opens a form instance.

1. On the Browser bar, ensure that the Stage/Role combination is 'Manager Approval/Manager'.

2. From the Form menu, select Preview. On the Details page you should see the following:

You are not able to enter any data in the top six input fields.

You are not able to enter any data in the table object.

You are not able to enter data in the Total object.

The Next page button is visible but the Submit button is hidden.

3. Click Next to open the Approvals page. The Approvals page should behave as follows:

The Manager Approval group is visible and editable but the other two groups are disabled (grayed out and not editable).

If you select Rejected but do not add a Comment, you receive a warning message when you click Submit and are not able to submit the
data. If you do add a comment you are able to submit the form.

Other Roles

Repeat the above for the combinations Director Approval/Finance and Director Approval/Executive to see similar behavior.



PerfectForms™ Tutorials 77

© 2015 PerfectForms™

Reporting Tutorial: Purchase Order Request

In this tutorial we will describe the steps necessary to create a new report as well as to add a variety of objects to that report. The basics of report design
are discussed in this tutorial and include understanding the concepts of:
 

Creating a new report

Attaching the report to a datasource which has been created by a published form

Selecting the report data (the fields on which you will report)

Adding objects such as bar and pie charts to your report

Adding data lists to your report

Setting up filters for your report

Saving and previewing your report

Set up: Loading the Sample Tutorial Form

If you have not completed the form tutorials, you can download a sample tutorial form with the preliminary steps complete by clicking here.

Note: This form is only available for download through the online version of this help guide.

1. To import a PerfectForms™ form (.PF), click the Import button under the Forms Dashboard tab. 

http://www.perfectforms.com/documentation/downloads/PurchaseOrderTutorial4(Form).zip
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2. Locate the .PF file on your PC. It will then be uploaded and added into your Private Forms folder. 

3. You can upload forms that have been exported from another account or downloaded from the PerfectForms™ Web site.

4. If you have downloaded and imported the sample form from the above link, it will be necessary to re-map the roles of Finance and Executive

to suitable Positions or Users in your PerfectForms™ system. If you plan to re-map positions, make sure that two suitable positions have

been created for your account. Contact your system administrator for details. To re-map positions, complete the following steps:

a. Open the form in design mode and click the Workflow area button  to access the Workflow diagram.

b. Click in the background of the diagram to select Workflow Properties.

c. Select the Executive role and click Edit.

d. Re-map to a Position or a User by selecting the appropriate radio button and clicking the Select button.

e. Repeat the process for the Finance role.

f. Save the form and exit.
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Create the New Report

Note: Prior to starting this tutorial, please ensure that your purchase order form has been published and that you have some instances completed and
submitted.

1. Log in to PerfectForms™. Click the Reports Dashboard tab then click the New button and choose Report from the drop-down menu.

The Report Designer loads a new empty report. The layout for report design is very similar to the Form Designer. There are three areas:

Toolbox/Browser bar on the left

Drawing canvas in the center

Properties on the right

2. With Report Properties selected in the Properties bar (click in background area), change the size to 550 x 450.

Attach a Datasource

Before laying out your report, you must first specify the datasource.
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1. On the Report Properties bar under the Data-Sources section, click New.

2. Click Select and browse to the Purchase Order form.

Note: You will only be allowed to select from published forms, including your own
forms and other shared forms to which you have reporting access.

 

     

Select Report Data

Once you have specified the datasource for the report, all of the available reportable objects will be listed. This includes the data objects on the form as
well as some instance properties (known as form meta data) such as instance name, stage, last submission date and more.

1. Select the fields that you want to report on by selecting the corresponding check box in the left most column. 

2. Notice that the full name of the field includes the page, group and object name. You can specify a shortened name in the Display Name

column.

3. From the list, choose the following fields and set the display names:

Field Name Display Name

Details - Group 14 - Applicant
Name

Applicant Name
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Field Name Display Name

Details - Group 14 - Department -
Value

Department

Details - Group 14 - Manager
Name

Manager Name

Details - Group 14 - Required by
date

Required by

Details - Total Total

Meta - Last Submission Date Last Submission Date

Meta - Stage Stage

Important: Do not select data from the table object at this time. If you report on data from a table object then each set of data for a row within
the table is considered as a separate instance. It is often better to create a new datasource for objects which report on table data.
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4. If you want to set a global report filter, click the Edit button.

5. Click OK when complete. It is possible to specify more than one datasource for reporting across multiple forms in a single report.

Add a Bar Chart

Now you build up your report using a combination of charts, lists and filter objects. Start with a bar chart which shows the number of instances in each
stage.

1. From the Toolbox, drag a Bar Chart object onto the center of the layout area.

Note: If there is only one datasource on the report, it is automatically selected. If there are multiple datasources, select the required one in
Bar Chart Properties. Although it is possible to report across multiple forms in a single report, each report object may only link to a single
datasource.

2. From the Group drop-down, select the field to report on which is 'Meta – Stage'.

3. Ensure that Count and Meta – Stage are selected in the Value section.

4. Click the Bar Chart object and on the Properties bar, select Can Set Dynamic Filter and Respect Dynamic Filters.

5. Size and position the chart. Add suitable text above the chart.

6. The sort mode can be changed in properties but for this chart it can remain unchanged.

Add a Pie Chart

Next we will add a pie chart to indicate the requests by department. This time we will neither allow nor respect drill down filtering.

1. Drag a Pie Chart object onto the report.

2. In Group select Department.

3. In Value select Count and Department (if not already selected).
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4. Clear the Can Set Dynamic Filter check box.

5. Clear the Respect Dynamic Filter check box.

6. Add suitable text above the chart.

7. Size and position all the objects.

8. Save and preview the report. Notice how clicking on the bar chart will enable a drill down filter in the bar chart but not in the pie chart.

Clicking on the pie chart does not initiate any drill down in either object.
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Add a Data List

Reports may also contain data lists. We will add one to the report to show the individual instance details. The data list will respect dynamic filters, but we
will not allow the list to be used as a drill-down filter.

1. Add a Data List object onto the page, re-size and position near the foot of the page, leaving room for navigation buttons.

2. In the Data List Properties under the Display section, select the Export Button check box. This will allow the user to export the data from

the table in CSV or XML format.

3. In the Columns section, click the Add Column button  five times.

4. Select each column in turn and specify the following settings (see screenshot below):
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Column 1: 

Caption = Applicant (mouse click in Caption box to change)

Field = Applicant Name (selected in the drop down)

Width = 100 px

5. Repeat the above for:

Column 2 = Department

Column 3 = Last Update (Use Last Submission Date), Sort select Descending

Column 4 = Total

Column 5 = Stage

6. Ensure that the Can Set Dynamic Filter check box is cleared.

7. Modify column widths accordingly. If the combined column widths are less than the total width of the Data List object the last column will

expand to take the remain width.

8. Preview the report to see how it looks and how the filters work.
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Set Up Filters

Objects on a report may be used as dynamic filters. Objects may also be set to either respect or not respect dynamic filters.

Although it is possible to use the drill-down method of filtering the report, it is also possible to add specific filter objects. We will add a simple
object to filter by department. Remember that the department pie chart will not be affected by this filter.

1. Add a Filter Selector object onto the page and position it to the left of the Bar Chart.

2. In properties set Type to 'List'.

3. Re-size and position accordingly.

4. In Field select 'Department'.

5. In Filter select the 'Override Previous' check box.

6.  Add suitable text.
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7. Add a Clear Filter button to the page and position it above the department filter. A re-click in a drill-down object will often clear a filter;

however it is more user-friendly to add a clear filter button on each page.

8.  Preview your report to see how it all works together with the different type of filters. 

Note: You can use an asterisk (*) to perform a wildcard search. Searching is not case sensitive. You should note that if you do not use a
wildcard at all, PerfectForms™ will automatically append one when searching. 

* Looks for any number of characters from that point onwards (Do*) or before that point ( *Doe)

? Performs a single character placeholder match (J?hn Doe)
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Include Table Data

When we specified the datasource we made a point of not using data from the table columns. Had we done this and then reported on the table data, each
entry (row) on the table would be considered as a separate instance; this could affect the results of existing reports.

We will now look at how we can report on the table data without affecting the existing reports. We manage this by creating a new datasource which
includes the table data along with data from other fields on the form. We will also apply a global filter to this datasource so only open order lines will be
shown.

1. From Report Properties and Datasources, create a new datasource.
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2. Select the same Purchase Order form as the Datasource.

3. Name the datasource ‘Purchase Order Table’.

4. Select the following fields to report on:

Applicant

Department

Description

Quantity

Price

Value

5. Click Edit to open the Datasource Filter Editor and set a filter to include only instances at Manager or Director Approval stages, then

click OK.
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6. Add a Next page button to the bottom of the report.

7. Add a new page by clicking the New button  in the Objects section of the Browser bar.

8. Copy graphics from Page 1 and paste onto the new page.

9. Add a Data List to the page near the bottom.

10.  Select the Export Button check box.

11.  From the Datasource drop-down, select Purchase Order Table.

12.  Select the following fields:

Name (Applicant Name)

Description



PerfectForms™ Tutorials 91

© 2015 PerfectForms™

Quantity

Price

Value

13.  Specify suitable column widths.

14.  Add a Page button to allow users to navigate to the previous page. 

15.  If you have some instances with two or more detail lines included in their tables, then you should see more lines in this new table than in the

table on the first page.

Add a Gauge

Gauges can also be useful indicators.

1. Add a Gauge object to the page.

2. Specify Max instances as 50.

Note: The maximum scale setting should be selected as a value beyond your expected maximum number of open order lines.

3. Select 'Purchase Order Tables' as the Datasource.

4. Select Count and Description.

5. Clear the Can Set Dynamic Filter check box.

Add a Calculation

Calculated values can be used.

1. Add a Text object and set text as 'Open Order Line Value'.
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2. Add a Value object.

3. Select 'Purchase Order Table' as the Datasource.

4. Select 'Sum of Value' as the Value.

5. Select the Respect Dynamic Filter check box.

6. Change font settings for text and value objects.

7. Align as needed.

Add a Filter for the Gauge

1. Filters can use a drop-down option. Add a Filter Selector object onto the form.

2. Set Type to 'Drop-down'.

3. Set the Datasource to 'Department'.

4. Select the Override Previous filter check box.

5. Add a Button object.

6. On the Properties bar, click the behavior event When Button is Pressed. 

7. Add a Close command to the Behavior canvas.

8. Change the button Caption to 'Close'.

9. Re-size and align objects accordingly.

Save and Preview the Report

Use the preview function to see your report.
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1. On the menu bar, select File > Preview. PerfectForms™ launches the report preview screen.

2. Close the report by clicking the close button  in the top right area of the screen.
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